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Introduction

You made the right choice twice: OS X Yosemite (OS X

10.10) and this book. Take a deep breath and get ready

to have a rollicking good time. That’s right. This is a

computer book, but it’s fun. What a concept! Whether

you’re brand spanking new to the Mac or a grizzled Mac

vet, I guarantee that reading this book to discover the

ins and outs of OS X Yosemite will make everything

easier. The publisher couldn’t say as much on the cover if

it weren’t true!

About This Book

This book’s roots lie with my international best seller

Macintosh System 7.5 For Dummies, an award-winning

book so good that now-deceased Mac cloner Power

Computing gave away a copy with every Mac clone it

sold. OS X Yosemite For Dummies is the latest revision

and has been, once again, completely updated to include

all the tasty OS X goodness in Yosemite. In other words,

this edition combines all the old, familiar features of

previous editions — but is once again updated to reflect

the latest and greatest offering from Apple as well as

feedback from readers.

Why write a For Dummies book about Yosemite? Well,

Yosemite is a big, somewhat complicated personal-

computer operating system. So I made OS X Yosemite

For Dummies a not-so-big, not-too-complicated book that

shows you what Yosemite is all about without boring you

to tears, confusing you, or poking you with sharp objects.

In fact, I think you’ll be so darned comfortable that I

wanted the title to be OS X Yosemite Made Easy, but the



publishers wouldn’t let me. Apparently, we For Dummies

authors have to follow some rules, and using For

Dummies and OS X Yosemite in this book’s title are

among them.

And speaking of “dummies” — remember, that’s just a

word. I don’t think you’re a dummy at all — quite the

opposite! My second choice for this book’s title was OS X

Yosemite For People Smart Enough to Know They Need

This Book, but you can just imagine what Wiley thought

of that. (“C’mon, that’s the whole point of the name!”

they insisted. “Besides, it’s shorter our way.”)

The book is chock-full of information and advice,

explaining everything you need to know about OS X in

language you can understand — along with timesaving

tips, tricks, techniques, and step-by-step instructions, all

served up in generous quantities.

Another rule we For Dummies authors must follow is that

our books cannot exceed a certain number of pages.

(Brevity is the soul of wit, and all that.) So I wish I could

have included some things, but they didn’t fit. Although I

feel confident you’ll find everything you need to know

about OS X Yosemite in this book, some things bear

further looking into, including these:

Information about some of the applications

(programs) that come with OS X Yosemite: An

installation of OS X Yosemite includes roughly 50

applications, mostly located in the Applications folder

and the Utilities folder within it. I’d love to walk you

through each one of them, but that would have

required a book a whole lot bigger, heavier, and more

expensive than this one.

I brief you on the small handful of bundled applications

essential to using OS X Yosemite and keep the focus



there — namely, Calendar, Contacts, Messages, Mail,

Safari, TextEdit, and the like—as well as important

utilities you may need to know how to use someday.

For what it’s worth, many books cover the applications

that come with OS X Yosemite, as well as applications

commonly bundled with Yosemite on a new Mac, such

as iLife; the one my publisher suggested I recommend

is OS X Yosemite All-in-One For Dummies, written by

Mark L. Chambers, which is (of course) also published

by Wiley.

Information about Microsoft Office, iLife, iWork,

Adobe Photoshop, Quicken, and most other

third-party applications: Okay, if all the gory details

of all the bundled (read: free) OS X Yosemite

applications don’t fit here, I think you’ll understand

why digging into third-party applications that cost

extra was out of the question.

Information about programming for the Mac:

This book is about using OS X Yosemite, not writing

code for it. Dozens of books — most of which are two

or three times the size of this book — cover

programming on the Mac; this one doesn’t.

Conventions Used in This

Book

To get the most out of this book, you need to know how I

do things and why. Here are a few conventions I use in

this book to make your life easier:

When I want you to open an item in a menu, I write

something like Choose File⇒Open, which means, “Pull



down the File menu and choose the Open command.”

Stuff you’re supposed to type appears in bold type,

like this.

Sometimes an entire sentence is in boldface, as

you see when I present a numbered list of steps.

In those cases, I leave the bold off what you’re

supposed to type, like this.

Web addresses, programming code (not much in this

book), and things that appear onscreen are shown in a

special monofont typeface, like this. (If you’re

reading an e-book version of this book, web addresses

are clickable links.)

For keyboard shortcuts, I write something like +A,

which means to hold down the  key (the one with the

little pretzel and/or  symbol on it) and then press the

A key on the keyboard. If you see something like 

+Shift+A, that means to hold down the  and Shift

keys while pressing the A key. Again, for clarity, I never

refer to the  key with the  symbol. I reserve that

symbol for the  menu (Apple menu). For the

Command key, I use only the  symbol. Got it? Very

cool.

Foolish Assumptions

Although I know what happens when you make

assumptions, I’ve made a few anyway. First, I assume

that you, gentle reader, know nothing about using OS X

— beyond knowing what a Mac is, that you want to use

OS X, that you want to understand OS X without having

to digest an incomprehensible technical manual, and that

you made the right choice by selecting this particular

book. And so I do my best to explain each new concept in



full and loving detail. Maybe that’s foolish, but … that’s

how I roll.

Oh, and I also assume that you can read. If you can’t,

ignore this paragraph.

Beyond the Book

I have written a lot of extra content that you won’t find in

this book. Go online to find the following:

The Cheat Sheet for this book is at

www.dummies.com/cheatsheet/osxyosemite

Online articles covering additional topics at

www.dummies.com/extras/osxyosemite

Updates to this book, if we have any, are at

www.dummies.com/extras/osxyosemite

Icons Used in This Book

Little round pictures (icons) appear off to the left side of

the text throughout this book. Consider these icons

miniature road signs, telling you a little something extra

about the topic at hand. Here’s what the different icons

look like and what they all mean.

 Look for Tip icons to find the juiciest morsels:

shortcuts, tips, and undocumented secrets about

Yosemite. Try them all; impress your friends!

http://www.dummies.com/cheatsheet/osxyosemite
http://www.dummies.com/extras/osxyosemite
http://www.dummies.com/extras/osxyosemite


 When you see this icon, it means that this

particular morsel is something that I think you

should memorize (or at least write on your shirt cuff).

 Put on your propeller-beanie hat and pocket

protector; these parts include the truly geeky stuff.

It’s certainly not required reading, but it must be

interesting or informative, or I wouldn’t have wasted

your time with it.

 Read these notes very, very, very carefully. (Did I

say very?) Warning icons flag important cautionary

information. The author and publisher won’t be

responsible if your Mac explodes or spews flaming

parts because you ignored a Warning icon. Just

kidding. Macs don’t explode or spew (with the

exception of a few choice PowerBook 5300s, which

won’t run Yosemite anyway). But I got your attention,

didn’t I?

 These icons represent my ranting or raving about

something that either bugs me or makes me smile.

When I’m ranting, imagine foam coming from my

mouth. Rants and raves are required to be

irreverent, irrelevant, or both. I try to keep them

short, for your sake.



 Well, now, what could this icon possibly be about?

Named by famous editorial consultant Mr. Obvious,

this icon highlights all things new and different in OS

X Yosemite.

Where to Go from Here

The first few chapters of this book are where I describe

the basic things that you need to understand to operate

your Mac effectively. If you’re new to Macs and OS X

Yosemite, start there.

Even though OS X Yosemite is somewhat different from

previous Mac operating systems, the first part of the

book is so basic that if you’ve been using a Mac for long,

you might think you know it all — and okay, you might

know most of it. But hey! Not-so-old-timers need a solid

foundation. So here’s my advice: Skip the stuff you know;

you’ll get to the better stuff faster.

 I would love to hear how this book worked for you.

So please send me your thoughts, platitudes, likes

and dislikes, and any other comments. Did this book

work for you? What did you like? What didn’t you

like? What questions were unanswered? Did you

want to know more (or less) about something? Tell

me! I have received more than 100 suggestions

about previous editions, many of which are

incorporated here. So please (please!) keep up the

good work! Email me at

Yosemite4Dummies@boblevitus.com. I appreciate

your feedback, and I try to respond to all reasonably

polite email within a few days.

mailto:Yosemite4Dummies@boblevitus.com


So what are you waiting for? Go! Enjoy the book!



Part I

Introducing OS X

Yosemite: The Basics

 Visit www.dummies.com for great For Dummies

content online.
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In this part …

In the beginning: The most basic of basics including

how to turn on your Mac.

A gentle introduction to the Yosemite Finder and its

Desktop.

Your Dock: Making it work harder for you.

Everything you need to know about Yosemite’s

windows, icons, and menus (oh my)!

All the bad puns and wisecracks you’ve come to

expect.

A plethora of Finder tips and tricks to make life with

Yosemite even easier (and more fulfilling).



Chapter 1

OS X Yosemite 101

(Prerequisites: None)

In This Chapter

 Understanding what an operating system is and is

not

 Turning on your Mac

 Getting to know the startup process

 Turning off your Mac

 Avoiding major Mac mistakes

 Pointing, clicking, dragging, and other uses for your

mouse

 Getting help from your Mac

Congratulate yourself on choosing OS X, which stands

for (Macintosh) Operating System X — and that’s the

Roman numeral ten, not the letter X (pronounced ten,

not ex). You made a smart move because you scored

more than just an operating system (OS) upgrade. OS X

Yosemite includes several new features that make using

your Mac easier and dozens of improvements that help

you do more work in less time.

In this chapter, I start at the very beginning and talk

about OS X in mostly abstract terms; then I move on to

explain what you need to know to use OS X Yosemite

successfully.



If you’ve been using OS X for a while, some of the

information in this chapter may seem hauntingly

familiar; a number of features that I describe haven’t

changed from earlier versions of OS X. But if you decide

to skip this chapter because you think you have all the

new stuff figured out, I assure you that you’ll miss at

least a couple of things that Apple didn’t bother to tell

you (as if you read every word in OS X Help — the only

user manual Apple provides — anyway!).

Tantalized? Let’s rock.

 One last thing: If you’re about to upgrade to

Yosemite from an earlier version of OS X, you might

want to peruse the article on installing and

reinstalling Yosemite in full and loving detail, found

at www.dummies.com/extras/osxyosemite.

Gnawing to the Core of OS

X

The operating system (that is, the OS in OS X) is what

makes a Mac a Mac. Without it, your Mac is a pile of

silicon and circuits — no smarter than a toaster.

“So what does an operating system do?” you ask. Good

question. The short answer is that an OS controls the

basic and most important functions of your computer. In

the case of OS X and your Mac, the operating system

Manages memory

Controls how windows, icons, and menus work

Keeps track of files

Manages networking

http://www.dummies.com/extras/osxyosemite


Does housekeeping (No kidding!)

Other forms of software, such as word processors and

web browsers, rely on the OS to create and maintain the

environment in which they work their magic. When you

create a memo, for example, the word processor

provides the tools for you to type and format the

information. In the background, the OS is the muscle for

the word processor, performing crucial functions such as

the following:

Providing the mechanism for drawing and moving the

onscreen window in which you write the memo

Keeping track of a file when you save it

Helping the word processor create drop-down menus

and dialogs for you to interact with

Communicating with other programs

And much, much more (stuff that only geeks could

care about)

So, armed with a little background in operating systems,

take a gander at the next section before you do anything

else with your Mac.

One last thing: As I mention in this book’s Introduction

(I’m repeating it here only in case you normally don’t

read introductions), OS X Yosemite comes with more

than 50 applications. Although I’d love to tell you all

about each and every one, I have only so many pages at

my disposal. If you need more info on the programs I

don’t cover, may I (again) recommend OS X Yosemite All-

in-One For Dummies, written by Mark L. Chambers, or

iLife For Dummies, written by my old friends Tony Bove

and Cheryl Rhodes (both published by Wiley).



 The Mac advantage

Most of the world’s personal computers use Microsoft Windows (although

more and more people are switching to the Mac). But you’re among the

lucky few to have a computer with an OS that’s intuitive, easy to use, and

(dare I say?) fun. If you don’t believe me, try using Windows for a day or two.

Go ahead. You probably won’t suffer any permanent damage. In fact, you’ll

really begin to appreciate how good you have it. Feel free to hug your Mac.

Or give it a peck on the disc drive slot (assuming that your Mac has one;

most, including the MacBook Air and Mac Mini at this writing, don’t). Just try

not to get your tongue caught.

As someone once told me, “Claiming that the Macintosh is inferior to

Windows because more people use Windows is like saying that all other

restaurants serve food that’s inferior to McDonald’s.”

We might be a minority, but Mac users have the best, most stable, most

modern all-purpose operating system in the world, and here’s why: Unix, on

which OS X is based, is widely regarded as the best industrial-strength

operating system on the planet. For now, just know that being based on Unix

means that a Mac running OS X will crash less often than an older (pre-OS X)

Mac or a Windows machine, which means less downtime. Being Unix-based

also means getting far fewer viruses and malicious software. But perhaps the

biggest advantage OS X has is that when an application crashes, it doesn’t

crash your entire computer, and you don’t have to restart the whole

computer to continue working.

By the way, since the advent of Intel-powered Macs a few years ago, you can

run Windows natively. That’s right — you can now install and run Microsoft

Windows on any Mac powered by an Intel processor, as I describe in Chapter

18. Don’t let that Unix stuff scare you. It’s there if you want it, but if you

don’t want it or don’t care (like most of us), you’ll rarely even know it’s

there. In fact, you’ll rarely (if ever) see the word Unix again in this book. As

far as you’re concerned, Unix under the hood means your Mac will just run

and run and run without crashing and crashing and crashing.

A Safety Net for the

Absolute Beginner (or Any

User)



In the following sections, I deal with the stuff that OS X

Help doesn’t cover — or doesn’t cover in nearly enough

detail. If you’re a first-time Macintosh user, please,

please read this section of the book carefully; it could

save your life. Okay, okay, perhaps I’m being overly

dramatic. What I mean to say is that reading this section

could save your Mac or your sanity. Even if you’re an

experienced Mac user, you may want to read this section.

Chances are you’ll see at least a few things you’ve

forgotten that will come in handy now that you’ve been

reminded of them.

Turning the dang thing on
Okay. This is the big moment — turning on your Mac!

Gaze at it longingly first, and say something cheesy, such

as, “You’re the most awesome computer I’ve ever

known.” If that doesn’t turn on your Mac (and it probably

won’t), keep reading.

Apple, in its infinite wisdom, has manufactured Macs

with power buttons on every conceivable surface: on the

front, side, and back of the computer itself, and even on

the keyboard and monitor.

So if you don’t know how to turn on your Mac, don’t feel

bad; just look in the manual or booklet that came with

your Mac. It’s at least one thing that the documentation

always covers.

 These days, most Macs have a Power button near the

keyboard (notebooks) or the back (iMacs). It usually

looks like the little circle thingy you see in the

margin.



 Don’t bother choosing Help⇒Mac Help, which

opens the Help Viewer program. It can’t tell you

where the switch is. Although the Help program is

good for finding out a lot of things, the location of

the power button isn’t among them. If you haven’t

found the switch and turned on the Mac, of course,

you can’t access Help anyway. (D’oh!)

What you should see on startup
When you finally do turn on your Macintosh, you set in

motion a sophisticated and complex series of events that

culminates in the loading of OS X and the appearance of

the OS X Desktop. After a small bit of whirring, buzzing,

and flashing (meaning that the OS is loading), OS X first

tests all your hardware — slots, ports, disks, random

access memory (RAM), and so on. If everything passes,

you hear a pleasing musical tone and see the tasteful

gray Apple logo in the middle of your screen, as shown in

Figure 1-1.

Figure 1-1: This is what you’ll see if everything is fine and dandy when you turn

on your Mac.

Here are the things that might happen when you power-

up your Mac:


